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Abstract: This article offers a brief introductory overview of Apple’s iBooks 

Author version 2.0, in particular new features relevant to language pedagogy, 

and how it can be used to create original e-books and instructional materials 

for Chinese (or other) language courses. Although other excellent 

applications used to create e-books are available, features new to iBooks 

Author 2.0, namely the addition of interactive widgets, differentiate it from 

other such applications. By providing immediate feedback to students, the 

Review widget in particular, I contend, has pedagogic benefits that make 

iBooks Author worthy of serious consideration for creating original course 

materials, despite proprietary limitations based on platform. The article will 

conclude with a summary of the benefits and limitations of using iBooks 

Author 2.0 to create instructional materials in Chinese.  

 

摘要: 本文简明扼要地介绍了苹果爱书2.0作者版本的全貌，尤其是新

增的有关语言教学的功能，以及如何用该版本来制作新颖的汉语及其它

语言课程的电子书和教学材料。尽管市面上也有别的优秀的应用软件，

但苹果爱书2.0作者版本的新功能，也就是互动视窗，令它从众多其他

应用版本中脱颖而出。我可以负责任的说，苹果爱书的复习视窗是很值

得考量的功能，尽管在使用平台上它有所有权方面的局限，但它通过给

学生提供及时的回馈，具备了在创作课程材料时的独特教学优势。本文

最后总结了使用苹果爱书2.0作者版本制作汉语教学材料方面的优点和

局限性。 
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1. Introduction 

In 1967, French critic and theorist Roland Barthes famously declared the “death of the 

author” in an eponymous essay (Barthes). In this influential piece, Barthes argued against a 

method of literary criticism and interpretation that would read a literary work primarily against 

the context of the author’s personal life and background. Although Barthes’ essay had a 

significant impact in cultural circles during the post-structuralist movement of the day and 

beyond, rumours of the demise of the author may have been somewhat exaggerated. With the 

advent of the Internet and the recent proliferation of social media, especially blogs, a new type of 

authorship has emerged; along with it comes a radically different kind of textual production and 

authorial empowerment (though not perforce always better, of course). Had he lived longer, 

Monsieur Barthes would have appreciated, I think, many of the transformations in reading and 

writing as well as the production and consumption of texts brought about by age of the personal 

computer and Internet. Hyperlinks now provide new ways and pathways of reading that are less 

linear than the conventional printed text. New software, such as Apple’s iBooks Author, allows 

anyone with a computer or even a mobile device to now become an author.  

 

This article offers an introductory overview of Apple’s iBooks Author version 2.0, in 

particular new features relevant to language pedagogy, and how it can be used to create original 

iBooks and instructional materials for Chinese (or other) language courses. The article is not, 

however, intended as an instructional manual or guidebook for the iBooks Author application; 

for such purposes, excellent publications and tutorials already exist (Cohen; Smolinski; Swanson) 

and can be referred to should readers wish to get a more complete and comprehensive overview 

of the application and all its various features and capabilities.   

 

Although other fine applications used to create e-books are available (Adobe’s InDesign, 

PagePlus, and even Microsoft Word), features new to iBooks Author 2.0, namely the addition of 

interactive widgets, differentiate it from other such applications. Widgets in iBooks Author 

Version 2, such as Gallery, Review, Interactive Images, 3D, HTML, Scrolling Sidebar, and Pop-

Over, introduce an element of interactivity, which makes works produced by iBooks Author 

unique compared to other e-books or standard print books. The Review widget in particular, I 

contend, has pedagogic benefits that make iBooks Author worthy of serious consideration for 

creating original course materials, despite proprietary limitations based on platform. Such 

widgets make iBooks Author more than just another tool to create digitized versions of textbooks 

or instructional materials; it allows for the creation of “transformative content,” which can go 

well beyond more conventional e-books’ highlighting or note-taking capabilities and thereby 

enhance learning.   

 

In what follows below, this article will: briefly introduce iBooks Author and some of its 

basic features and functionality; provide a brief overview of how to create an iBook in the 

application; examine the new widget features and their possible uses for creating instructional 

materials; cover how to share iBooks or publish through the iBooks Store materials, including 

iBooks, created using iBooks Author; and conclude with discussion of both the benefits and 

limitations of using iBooks Author to create original instructional materials in Chinese. 
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2. What is iBooks Author? 

 

With an Apple computer and iBooks Author, one can create a wide range of instructional 

materials easily and professionally, from stand-alone reading, vocabulary or listening 

assignments and other exercises to full-length language textbooks with text, graphics, 

multimedia files, and interactive functionality. Anything created using iBooks Author can be 

conveniently shared as an email attachment (depending on file size) or through file sharing 

services (such as Dropbox), iTunes U, or the iBooksStore. E-books or materials made with 

iBooks Author (.ibooks files), however, can only be read using Apple’s iBooks application.  

 

iBooks Author can be downloaded from the Apple App Store free of charge for anyone 

with an account. A localized Chinese version is also available through the App Store. The 412 

MB download requires 1.2 GB of available disk space, 2 GB of RAM, and Apple’s operating 

system 10.9 (Maverick) or later (the latest version is Yosemite, 10.10.3, with OS 10.11, El 

Capitan, due out fall 2015). Since OS 10.8, Apple has made its operating system upgrades free to 

all users. Free versions of both operating system software and iBooks Author should be 

appealing to educators and educational institutions, especially if budgetary constraints are an 

issue. For importing extant Keynote or Pages files into iBooks Author, versions 6.0 and 5.0 of 

those applications are required respectively. For previewing and reading iBooks, at least version 

3.0 of the iBooks application is required for the iOS platform (version 7); the latest version of 

iBooks for the iPad and iPhone, 4.2, requires iOS 8. For the Mac desktop and laptop OS, the 

latest version of iBooks is 1.1.1. Some functions and features of iBooks 1.0 available only on 

Apple computers and laptops offer additional pedagogic benefits for language learning and will 

be covered in greater detail below. Finally, iTunes producer 2.9, also free, is needed should 

authors wish to publish their books on iTunes U or through the iBooks Store. File size 

for .ibooks files uploaded to the iBooks Store is capped at 3 gigabytes.  

 

Released 16 October 2014, the latest version of iBooks Author is 2.2. Version 2.2 offers 

many new features, including the ability to import ePub and Adobe InDesign IDML files, blank 

templates to create customized books, hyperlink options to link to a location in another book or 

from an image, improvements in transitions in the Keynote widget, as well as the ability to 

enable auto-play for Keynote slideshows, and HTML and media widgets. Version 2.0 also 

includes many major improvements, most notably greater support for more audio and video file 

types, customizable fonts, and, of course, widgets, which are the main focus of this article.  

 

 

3. Getting started 

 

As with many other Apple applications, using iBooks Author is relatively simple and 

intuitive. Yet, as we shall see below, iBooks Author also possesses fairly powerful features that 

make creating sophisticated and professional iBooks fairly easy. Ideally, one should first  collect 

instructional materials or “assets” that will make up the content of the iBook. Materials can 

include text, images, graphics, audio files, and movies. In Take Control of iBooks Author, the 

author suggests thinking ahead of time about how an iBook should “flow” and offers suggestions 

in planning the organization and layout of works created in iBooks Author (Cohen). Although 

one could create and edit textual material from within the iBooks Author application itself, 

http://www.dropbox.com/
http://www.apple.com/education/ipad/itunes-u/?cid=wwa-us-kwg-features-com
https://www.apple.com/ibooks/
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authors may find it easier to first develop content in an external application, such as Word or 

Scrivener. One can then either direcctly import content from external applications, such as Word, 

Pages, e-pubs, or Adobe’s InDesign IDML files, or cut and paste content directly into iBooks 

Author’s chapters, sections, and pages.  

 

Upon opening the application, users are first presented with the Template Chooser 

window. By default, one can choose from ten landscape with portrait mode templates or seven 

portrait-only mode templates. Other templates are also available for purchase or as free 

downloads through the App Store. Although iBooks on mobile devices can display both 

landscape and portrait modes and will adjust formatting automatically, it is important to consider 

which mode to use when starting out. Portrait only resembles the conventional print book in 

terms of format should authors prefer this. But portrait-only mode can, as the name implies, only 

be displayed in portrait mode. Thus, prospective authors beware.   

 

After selecting a template, a new iBooks Author file (.iba) will be created. By default, 

each new iBook is created with a book title, introductory media, a Table of Contents, which is 

updated automatically as chapters and titles are added, a glossary, and a sample chapter, 

including sections and pages. These are shown in the side bar of the document window. In the 

side bar, chapters can be moved by dragging and dropping to change the order of chapters in the 

book (the Table of Contents will reflect these changes automatically). Turn-down triangles for 

chapters, sections, and pages save space in the side bar and make navigating through longer 

iBooks easier. Sections and pages, however, cannot be moved in the side bar this way and must 

be edited from within each chapter. Chapters include by default the chapter first page, section 

first page, and a page with filler text populating it. It is therefore easy to get started and fill in 

text, graphics, and other media as needed. Or one may start fresh by right-clicking and selecting 

“delete chapter” or by selecting a blank template to begin with (in either landscape and portrait 

or portrait-only mode). 

 

Adding existing content from Word, Pages, or IDML files is possible by going to the 

Insert menu and selecting “Insert Chapter From...” and then choosing the corresponding file to 

be imported. To create section breaks in the iBooks Authors document during the import, make 

sure first to insert section breaks in the original Word or Pages file. This is a most convenient 

way to create new or preserve old formatting during the import. This feature is also an effective 

way to integrate already created materials in Word, Pages, or IDML files into a new iBook.  

 

Those familiar with Apple’s Pages and Keynote applications will find the iBook Author’s 

Toolbar and Inspector window to be quite familiar. Save for features unique to each application, 

the Toolbars and Inspector are virtually identical in iBooks Author, Pages, and Keynote. For 

users less familiar with these applications’ interface, general knowledge of word processing 

programs such as Word should suffice to format iBooks as one wishes.  iBooks Author makes it 

easy to format text, graphics, media, and layout once a template has been selected or new 

chapters, sections, or pages have been added. Under preferences, users may wish to select to 

“show alignment guides” to help with formatting. Go to Preferences under the iBooks Author 

menu and choose Ruler. Under Ruler Preferences, select “Show guides at object center” and 

“Show guides at object edges.” Alignment guides make designing and creating professional-

looking text and graphics intuitive, efficient, and accurate. 
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In iBooks Author, the toolbar is also customizable as it is in other Apple applications. 

The default set includes: Add Pages; View; Orientation; Text Box; Shapes; Table; Charts; 

Widgets; Preview; Publish; Inspector; Media; Colors; Font. Other tools, such as Instant Alpha 

and Mask for images, can be added to the Toolbar or accessed through the various iBooks 

Author menus (Format > Image >). The View tool allows users to show or hide the following: 

the glossary tool bar (which may be helpful for creating language-related materials and will be 

discussed below); the styles drawer; layouts; the format bar (for text); rulers; layout boundaries; 

and invisibles. It should be noted that layout styles can be customized, too, and saved as part of a 

custom template. The simplest way to do this is to show layouts in the View tool, duplicate a 

layout and rename it, then make the desired changes to the new layout style. This is especially 

helpful if using a customized style repeatedly for creating original materials.  

 

The Orientation tool allows authors to see how their work will look in either landscape or 

portrait mode from within the iBooks Author application before sending the iBook to either an 

iPad or computer. This is done through the Preview function, and is a great time saver for 

designing one’s iBook. The Preview tool allows authors to see how their works will actually 

look in iBooks 4.0 on either a connected iPad or on an Apple computer should it have iBooks 1.0 

installed. If authors are working with larger or longer documents, it may be useful to select 

“Preview the current section” instead of “Preview entire book” from the General tab under 

iBooks Author Preferences. Bear in mind that longer iBooks or documents with audio, video, or 

graphics may take some time to load completely through the Preview function. The Publish tool 

button starts the process of actually publishing one’s iBook through the iBooks Store, which will 

be covered later in the article. Publishing can also be done through File > Publish or a keyboard 

command.  

 

One feature that language instructors should find quite useful in iBooks Author is the 

Glossary, which is included by default in all templates and can be found in the side bar. The 

Glossary toolbar can be turned on by going to the View button in the Toolbar or the View menu 

and selecting “Show Glossary Toolbar.” There are three ways to add terms to the glossary. First, 

one can go to the glossary itself by either clicking on it in the sidebar or by clicking on the 

Glossary arrow on the right-hand side of the Glossary toolbar (which must be displayed). The 

glossary arrow button is a quick way to toggle between the document text and the glossary. From 

the glossary, one can manually add new terms by clicking on the + button and entering the term 

in the text field. Second, one can also find the actual term in the text, highlight it (or double-click 

on it), then right click and add the term to the glossary by selecting “create glossary term from 

selection” from the pop-up contextual menu. Lastly, one can highlight a term, which will then 

appear in the Glossary toolbar “New Glossary Term” text field. Clicking the “Add Term” button 

next to the text field will enter the newly selected term in the glossary. This last method 

generally proves to be the quickest of the three. 

 

Terms added to the glossary will be listed alphabetically in the “Terms” column. Next to 

it authors can set the status of the terms using three colored dots (green, blue, and orange) as they 

see fit. A blue dot marks the default status of new terms. Other dots could be used to indicate the 

status of glossary items (created, in-progress, and completed, for example). For glossary terms in 

Chinese characters, iBooks Author will list them alphabetically, too, according to their initial and 

final. This works quite well and is most convenient for creating an easily navigable glossary of 
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Chinese terms in characters. It does not handle well, however, characters with more than one 

pronunciation. For example, entering the character还as hái will not work; iBooks Author 

glossary takes it instead as huán and lists it as such. I have not yet found a workaround for this 

issue, which is more serious for characters with different pronunciations whose initials are not 

close alphabetically (say for example解,which can be read as jiě or xiè). Nevertheless, characters 

will be listed alphabetically in correct order for the most part.  

 

 One shortcoming to the glossary feature is that all definitions must be added to the 

glossary manually. This is not too difficult, however, if using the Dictionary application that 

comes standard with the Mac operating system. OS 10.10 (Yosemite) includes several excellent 

English, Chinese, and Chinese-English dictionaries: the New Oxford American Dictionary (2013), 

The Standard Dictionary of Contemporary Chinese(2012), and the Oxford English-Chinese 

Chinese-English Dictionary (2013). Authors need only look up a term in the Dictionary 

application, then cut and paste the proper definition into the glossary window definition field on 

the right. Related glossary terms for any given entry can be created easily by simply dragging 

related terms from the list of glossary items on the left to the related glossary terms list under the 

definition on the right. 

 

Finally, the glossary also offers indexing functionality. By clicking on the “index” button 

under the definition, one can use the “find and replace” window to search for other instances of 

the same term in a text. To add other instances of a term to the index, simply click on the “add 

link” button on the glossary toolbar. That particular instance of a term will then be added to the 

index of that glossary term, showing its location in the iBook. Glossing and indexing are thus 

made easy in iBooks Author. Being able to create glossaries and indices easily is another 

powerful tool for authoring instructional materials, especially for reading assignments or 

acquiring vocabulary.  

 

When viewed in iBooks on a mobile device or computer, glossed terms will show up in 

bold. Tapping on a glossary term will display the user-defined definition in a pop-up window. By 

tapping on the “dictionary” button at the bottom of the pop-up window, the dictionary definition 

of the term will also be shown (in the case they differ in level of detail). Tapping the “glossary 

index” button at the bottom will show the other related terms, if any, and other index links, if any, 

that were added. Another useful feature found in the “dictionary” pop-up window (activated by 

hitting the dictionary button) is an option to search Wikipedia or the web by clicking on their 

respective buttons on the bottom of the window. One major drawback, however, to the glossary 

function in iBooks when using Chinese characters stems from the characters not displaying 

noticeably bolder in iBooks, which is the prompt for readers to know that it is a glossed term. For 

readers using iBooks 1.0 on the Mac platform, it is also possible to actually look up any Chinese 

term in a text—glossed or not— using the Dictionary application through key commands or 

gestures. This, however, is unfortunately not possible presently on the mobile iOS. Glossed 

terms in Chinese text may nevertheless still prove helpful, even though it may be difficult for 

readers to discern Chinese characters in bold in the iBooks application on mobile devices.  

 

Before turning our attention to Widgets, let us finally look at one final item in the default 

toolbar that is most crucial in the creation of iBooks, namely, the Inspector. Users of earlier 

versions of Pages and Keynote should already be familiar with the Inspector window, even 
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though the latest version of both applications has moved it to a sidebar located inside of the 

document window. For longtime users of Microsoft Word, the iBooks Author Inspector window 

is akin to the palette in older versions of the word processing application. The Inspector window 

can be used to change formatting and other aspects of your iBook that are not available through 

drop-down menu options. It includes the following ten panes: Document, Layout, Wrap, Text, 

Graphic, Metrics, Table, Chart, Link, and Widget. In iBooks Author, multiple Inspector windows 

can be open simultaneously, which facilitates authoring certain content. From the menu, go to 

View > New Inspector and select the pane needed for the task at hand.  

 

In the Document Inspector, users can fill in metadata in the Author, Title, Keywords, and 

Comment fields. This can be useful later should authors wish to publish their work through the 

iBooks Store. Data about the iBooks Author document, such as word, character, pages, and 

graphics count, can be gleaned from here as well. There is also an option to “disable portrait 

orientation” if one intends for an iBook to be read only in landscape orientation (books with 

movie files, for example). Modifications to what is or is not displayed in the default Table of 

Contents page (created automatically when a template is selected), such as adding or deleting 

copyright information, dedications, a foreword, or sections and paragraph styles, can be done 

under the TOC pane in this Inspector. In an iBook, tapping on any item in the Table of Contents 

will bring the reader directly to that chapter, section, or page of the book, which makes 

navigating through the text easy and effective.  

 

The Layout Inspector allows users to create multiple columns and set gutter width 

between columns. Just highlight text from the document and select the number of columns to be 

displayed. Numbering and lettering for chapter and sections as well as pages can also be changed 

from this Inspector window. Numbering for chapters and section can be relative to the book, 

chapter, or none. For chapters, sections, and pages, numbering may be continuous or start with a 

given number entered into a blank field. If one wants Chapter 1 to begin on page 5 after the 

“Introduction,” for example, select “starts at” and enter 5 into the blank field. Various formatting 

options exist for numbering and lettering as well (1, 2, 3; i, ii, iii; A, B, C; a, b, c, etc.). Such 

options are useful if one wishes to follow publishing formatting for conventional books, which 

generally use a combination of Arabic and Roman numerals. In terms of pagination, iBooks 

Author is thus similar to most word processing software.  

 

The Wrap Inspector determines how text will interact with images surrounding it.  iBooks 

Author offers options for inline (moves with text), floating (does not move with text), or 

anchored (stays with anchor) object placement. The anchor option is helpful in the event that one 

adds text to or deletes text from a document, which would cause a change in formatting and 

pagination. In other words, anchoring ensures that text and image stay together. Selecting “object 

causes wrap” controls how text will arrange itself around an image in floating mode. For 

example, a u-shaped wrap would wrap around an image with no text on either the right or left 

margin of the page. Surrounding wrap would surround an image with text on all sides. Text can 

also wrap above and below an image, leaving a blank space to the right and left of the image. 

Wrap makes formatting text and graphics together simple and adds a highly professional look to 

iBooks. In the Wrap Inspector, an option to select “text fit” is also available. This determines 

how close the text will be to any given wrapped object. “Text fit” can also make text wrap 

around irregularly shaped objects like, say, a star. Objects must, however, be transparent (no 
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negative space, such as a square white background). For this purpose, .png files work best. But 

with Apple’s Instant Alpha feature, one can remove the background of a .jpeg file, for example, 

and thus make it “transparent” for the purposes of wrapping text around it. With Instant Alpha 

and Edit Mask, images can be modified right within the iBooks Author application, which is 

more convenient than editing them with a different external application.  

 

Under the Text Inspector, more conventional word processing editing controls can be 

found. Attributes related to text, such as color, spacing, alignment, margins, lists, indents, tabs, 

borders, background fill, and pagination, can all be modified from the Text, List, Tabs, and More 

panes in the Text Inspector. For modifying attributes of graphics created in iBooks Author, the 

Graphic Inspector allows users to change fill, stroke (line or picture frame), opacity, and shadow. 

Further modifications to images and graphics can be made under the Metrics Inspector. Changes 

can be made to the dimensions of an image or graphic (including reversion to original size), 

position (x and y axis), and angle of rotation. Images can also be flipped, both horizontally and 

vertically, under the Metrics Inspector. Oddly, Apple software interface designers chose to create 

two separate Inspectors for graphics and metrics for some reason.  

 

The next Inspectors are Table and Chart. These understandably seem less relevant to the 

creation of instructional materials in Chinese or other languages. But tables could be used to 

create neatly aligned vocabulary lists with rows used to list lexical terms and columns dedicated 

to characters, pīnyīn, definition, and parts of speech. Rows and columns can be modified 

(number and size) easily from within the Inspector. An option to alternate row color also exists, 

which may make reading a vocabulary list easier visually. In iBooks Author, one can thus easily 

produce vocabulary lists similar to what is seen in conventional text books by using tables to 

create lists, add alternating shades between rows, and deleting separator lines between text fields. 

 

Under the Link Inspector, one can create a variety of different hyperlinks to various 

targets. Selected text or graphics can be linked to webpages, email, bookmarks, figures (images, 

graphics, or widgets within iBooks Author), chapters or sections, or page numbers. If “link to 

figures” is selected, iBooks Author will display all figure styles, namely, audio, diagrams, figures, 

galleries (widget), illustrations, review (widget), images, interactive, and movies. A figure, such 

as an image, graphic, or widget, can be created by selecting the intended figure and going to the 

Widget Inspector. There under the Title pane, one selects “label” from the drop-down menu and 

chooses the appropriate type of figure (diagram, figure, gallery, illustration, image, interactive, 

movie, or review). The newly created figure will then appear back in the Link Inspector, where it 

can be selected and linked to. Bookmarks can also be added to a particular page and hyperlinked 

to targets. Hyperlinks are not only a convenient way to navigate through an iBook; they also 

provide powerful heuristic tools that, if used properly, can enhance the act of reading and 

processing information. The last Inspector window is dedicated to widgets, upon which we will 

now focus our attention.  

 

4. Widgets 

 

As noted above, widgets are new to iBooks Author version 2.0 and are what make it 

different than other e-book creation applications on the market. The nine new interactive widgets 

are: Gallery; Media; Review; Keynote; Interactive Image; 3D Image; HTML; Scrolling Sidebar; 
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and Pop-Over. Of these, Review may have the greatest pedagogic potential for learning 

outcomes and assessment and will be introduced first here.  

 

The Review widget allows readers to check what they have learned through multiple-

choice and drag-to-target types of questions. There are four types of multiple-choice formats 

currently available in the Review widget: text; text and image in landscape; text and image in 

portrait; and answers as images. Although somewhat limited in capability at this point, the 

pedagogic benefits of this widget stem from its ability to provide immediate feedback to students 

about what they have or have not learned. Research has demonstrated convincingly the positive 

effects of feedback on all areas of learning (Askew, 2000; Shohamy& Walton, 1992; Wiggins, 

1997). These studies have overwhelmingly concluded that feedback is more effective the sooner 

it is provided to students. Language learning is no exception to this. In fact, with certain skills, 

such as listening comprehension, immediate feedback is all the more critical. Learners are less 

likely to remember what they heard either correctly or incorrectly on a listening comprehension 

exercise or assignment with the passage of time. Immediate feedback is also effective in the 

learning and acquisition of vocabulary. The Review widget thus could work very well for 

designing and creating both listening comprehension exercises and vocabulary exercises. 

Answers can be given immediately by clicking “Show Answer” and the total number of correct 

answers can displayed at the end of a series of questions. For the time being, however, there is no 

way to record the score or number of correct answers for any given assignment.  

 

One could create a simple Review exercise by inserting an audio or movie file through 

the Media widget, asking students to listen or view a passage, then have them answer questions 

that follow using the Review widget. After inserting the Review widget, questions and answers 

are created through the Inspector. Under the Layout pane, authors can choose the label type 

(Review), and whether or not to show the title and background in the Review frame in iBooks 

Author. iBooks Author will automatically number Review questions sequentially, which will be 

displayed as 1.1 for Chapter 1, question 1 if the “Show title” box is checked. Adding another 

Review widget will create 1.2 and so on. This is convenient for referencing questions or 

assignments by chapter and within chapters as homework assignments. Authors can add a 

description, such as “Chapter Vocabulary,” after the sequentially numbered titles in the 

“Accessibility Description” field of the Layout pane of the Review Inspector. For each Review 

widget frame, for example, 1.1, 1.2, and so on, any number of multiple-choice questions can be 

asked. In other words, Review is not one widget, one question. iBooks Author will automatically 

create a heading in the frame to indicate “Question 1 of 3, Question 2 of 3,” etc.  

 

The actual questions are created under the Interaction pane of the Review Inspector.  

Questions and type of questions (multiple choice or drag-to-target) are created by clicking on the 

+ button at the bottom of the questions field in the Inspector. For each Review widget question, 

the number of questions is not limited; the number of possible answers to multiple-choice 

questions, however, is variable and ranges from two to six (both multiple choice or drag-to-

target). Once a Review question is created, authors enter the text for both the question and the 

answers in the document window (Widget frame), not the Inspector. The Inspector will display 

what is in the document window but cannot be used to input text. The correct answer for any 

type of question is indicated by simply clicking on it (as a student would in replying), which will 

mark it with a green check box.  
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In addition to multiple-choice questions as all text, there are options to have an image in 

landscape or portrait mode with two to six possible answers. Images could work well for 

assessing vocabulary items, with the lexical term being tested shown as an image and the 

multiple-choice answers displayed in characters. A final option for multiple-choice questions 

would be a question in text and answers (again two to six) shown as images instead of text. This, 

too, would work well for assessing acquisition of vocabulary items, especially nouns. Although 

rather limited in types of questions that can be asked, especially in comparison to other online 

assessment tools, course management systems, or publishers’ companion websites, it is easy to 

create questions using the Review widget. It is also adequate, I believe, for assessing certain 

skills and tasks, such as listening, reading, and vocabulary. When shown Review questions in 

iBooks on either the iOS or Mac platform, students tap on a selected answer, which can be 

checked immediately by hitting the “check answer” button at the bottom of the frame. At the end 

of a series of questions, the number of correct responses will be shown. There is also an option in 

iBooks Author for Review questions to be shown as thumbnails, which saves on limited screen 

real estate on iPads and smaller laptops. Students can also retake Review questions as many 

times as they like. Studies have shown that prompt feedback and recasts can enhance the 

acquisition of vocabulary in learning another language (Dilans, 2010).  

 

The second type of Review question is drag-to-target. In drag-to-target, identifications 

are made by dragging either labels or thumbnails in the Review widget frame to the correct target 

image. As with multiple-choice questions, the number of possible answers ranges from two to six. 

This type of question is perhaps most useful for assessing acquisition of vocabulary items. An 

author could, for example, use an image of various fruits and then create labels with the name in 

Chinese of each fruit. Target labels are created by typing text in the label attached to a circle. 

When this is done, a corresponding label, located at the bottom of the frame (label without a 

target circle) is created. The labels in the bottom of the frame are what students drag to targets on 

the image. For authors, dragging the newly created labels in iBooks Author to the correct 

position of the corresponding fruits in the image sets the correct answers. When students see a 

Review widget drag-to-target type of question, they will drag labels from the bottom of the frame 

to what they think is the correct spot on the image. As with multiple-choice questions, students 

can check their answers for each question immediately and see how many questions they 

answered correctly. Once again, immediate feedback, so crucial to learning, is provided with this 

type of interactive exercise. The drag-thumbnail-to target seems less useful for language learning 

and will not be discussed here. The procedure is, however the same as creating target labels, save 

for using thumbnail images in lieu of labels.  

 

Gallery is another new widget that authors may find useful for creating materials for 

Chinese instructional purposes. Essentially a photo gallery, it could be used to create images for 

vocabulary items or lexical sets. The introduction of new vocabulary items in Gallery could then 

be followed up by using Review to assess acquisition of terms. In Gallery, images can be 

browsed on a single page. As with Review, Galleries are numbered sequentially by chapter and 

number of series in chapter. There is also an option under the Layout pane in the Inspector to edit 

Gallery label styles and make them either book relative or chapter relative.   Images can be added 

to the Gallery widget through the Inspector by clicking on the + button under the Interaction 

pane or by dragging and dropping images from a local computer or the Media window (located 
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on the Toolbar). Selected images then show up in the Gallery widget frame either as thumbnails 

if “Show Thumbnails” is selected in the Interaction pane or as a slide show controlled by forward 

and back arrows. Dots between the arrows indicate the number of photos and place in the slide 

show. There is no indication of the upper limit of the number of images that can be added. But 

some authors have created Galleries with over 100 images. After adding images, authors can 

switch to the Layout pane in the Gallery Inspector and choose whether they want text on the top 

only, both top and bottom, or both on the bottom. By selecting the top and bottom choice for 

layout of accompanying text, the header could be used display the category of vocabulary, say, 

animals, whereas the footer caption would display the definition for each individual image of an 

animal. Visually this could be an effective way to teach and learn lexical sets or vocabulary.  

 

The Media widget, not to be confused with the Media browser, is not unique to e-book 

authoring in terms of support for audio or video files. But in iBooks Author 2.0, more media file 

formats are supported. Now any files that can be opened by QuickTime Player are supported. 

The most current list can be found here. Authors can drag and drop audio or video files into 

iBooks Author and a Media widget will be created automatically. As with Gallery, Media frames 

will automatically be numbered sequentially. There is also an option under the Layout pane for 

text and captions to be on the top of the frame only, on both the top and bottom, or just at the 

bottom. If authors want just the button or toolbar to be displayed, the title, caption, and 

background can be removed by unchecking them from the Layout pane of the Media Inspector. 

On the Interaction pane of the Media Inspector, there is a choice to select either “plays on page” 

or “plays full-screen.” It is recommended that authors select “plays full-screen” for movies so 

that they can be viewed properly in iBooks on smaller mobile devices. Otherwise, the videos 

may appear too small if played “on page.”  

 

As to controls, media files can be displayed with buttons, scrubber bars, or poster frame 

images. The scrubber bar may be the most helpful for students to control playback of files. This 

is especially the case should media be used for listening exercises, as the scrubber bar allows for 

greater control over segments of the media file being played. Students could drag the scrubber 

back, for example, to listen to a passage or segment again should they not  have understand it 

completely, have questions, or wish to reconfirm what they have heard. As with Gallery, the 

Media widget could be used effectively in conjunction with Review to create self-paced 

exercises and assignments. Even used simply for audio or visual media, audio and video files can 

create a more fully multi-media experience for iBooks. For a digraphic and tonal language such 

as Chinese, having audio files of text in characters or even pīnyīn is helpful for language learners.  

 

For authors wishing to share Keynote slide shows, this can be done easily in iBooks 

Author with the Keynote widget. After inserting a Keynote widget, slide shows can be added 

simply by dragging and dropping a Keynote file (.key) onto the widget. Adding Powerpoint 

slides is possible, too, by first opening up .ppt or .pptx documents in Keynote. Simply saving the 

opened Powerpoint document in Keynote will convert it to a Keynote (.key) file, which can then 

be used in iBooks Author through the Keynote widget. Some editing and modifications may be 

necessary, however. But generally the two applications have become quite compatible, especially 

in the latest versions of the software.  

 

 Slightly different layout options from the other widgets are available for the Keynote 

https://support.apple.com/en-us/HT201290
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widget. Instead of text on top, both top and bottom, or only bottom, there are choices for top and 

bottom or bottom only as well as free-form layout and banner layout, in which text can displayed 

over the Keynote widget slide in banner form. Title and captions can be displayed or not 

displayed by clicking buttons on the Layout pane of the Keynote Inspector. As with other 

widgets, it is possible to edit how title labels display by clicking on Labels under the Layout pane. 

This is useful should one wish to create customized titles that will nevertheless order Keynote 

widgets sequentially (say, for example, Lesson 1, Lesson 2, Lesson 3, etc).  

 

Under the Interaction pane on the Keynote Inspector, there are options to play slideshows 

“full-screen” or “on page.” As with movies, the full-screen option is recommended for Keynote, 

especially if played in iBooks on mobile devices. Options also exist to “Play automatically” and 

“Show transport controls,” though these only work with the “play on page” option. In iBooks 

full-screen mode, readers start the slide show by clicking on the Keynote widget, which will 

open the slide show in full-screen mode. In iBooks 1.0 for the Mac OS, the slide show can be 

advanced by clicking on the space bar or using the forward directional arrow. Readers can move 

forward and backward between slides or between builds, which are preserved by the widget, by 

using the four directional arrow keys on the keyboard. On mobile devices, tapping begins a slide 

show. Reverse pinch to view slideshows full screen on the iPad. Slides and builds can be 

advanced or reversed on mobile devices by using a swiping motion in the direction one wishes to 

go (if in full-screen view). Otherwise, transport control arrows can be used to control the 

slideshow in page view. When finished, readers can click on the “done” button to exit the 

slideshow.  

 

For all my Chinese language classes, I use Keynote to introduce vocabulary, grammar, 

key sentence patterns, and for classroom exercises. Slides are shared with students as a PDF via 

our university course management system, D2L. Students in general find the slides a good way 

to review materials, even if just in PDF form. Pairing a slideshow in the Keynote widget with 

Review, however, will allow students to preview and review new material, then self-assess what 

they have learned. Again, offering immediate feedback through interactive widgets has 

pedagogic benefits that other e-book authoring software or PDF files cannot provide. With 

Review, it would be easy to create multiple-choice questions or drag-to-target exercises to assess 

acquisition of vocabulary terms or syntax-related questions about sentence patterns or grammar 

from Keynote slides. Finally, for some odd reason media files embedded in Keynote but not 

supported by iBooks Author as stand-alone files will play properly if imported into the Keynote 

widget as part of a slide show. This could serve as a workaround to unsupported media file types, 

though it may be easier to simply convert such files to formats that iBooks Author does support.  

 

The last two widgets to be introduced are Scrolling Sidebar and Pop-Over. Both of these 

widgets, which function something like a gloss, allow authors to add text to graphics or images 

or as a standalone text box. They could therefore be more useful for adding additional 

information to the culture notes section of a text. For example, one could add a Scrolling Sidebar 

widget to an image of the terracotta warriors or a traditional Chinese courtyard home with an 

introduction in Chinese or English filling the Scrolling Sidebar. In iBooks 1.0 for the Mac OS, 

the operating system dictionary function is also available to look up terms in Chinese should the 

Sidebar include text in characters. Selected text can also be read aloud through text-to-voice 

capability (highlight text, right click, select “speech” > “start speaking”; see below for more 
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information about how to set this up). In Scrolling Sidebar, a text box is created after a widget is 

inserted. In the Inspector, there are options to include a title, caption, background, and border to 

the text box. Within the text box itself, small images or graphics can also be placed. But any such 

graphics cannot be expanded or zoomed in when viewed in iBooks and are thus of limited use, 

save perhaps for aesthetic reasons or design purposes.  

 

The Pop-Over widget is similar to Scrolling Sidebar in that it provides a pop-up text gloss 

for graphics and images. After inserting the Pop-Over widget, a graphic icon and text box, with 

prompt to add text appears. Under Layout in the Inspector Layout pane, there are different 

options for displaying titles and captions for the pop-up window: top or bottom; just bottom; free 

form; left or right side; and banner. An option to not display title or captions also exists. But it 

may be helpful for readers to at least have a prompt letting them know that tapping on an image 

or graphic will make the Pop-Over window and text display. For longer text passages, a side 

scrolling bar will appear in the Pop-Over window. Like the Scrolling Sidebar widget, there is 

also an option to include images or graphics with text in the Pop-Over window. But any such 

graphics cannot be enlarged in iBooks. Although similar in functionality to Scrolling Sidebar, 

Pop-Over may be more helpful to gloss a set or series of images or graphics on a single iBooks 

page. Pop-Overs are essentially space savers on the iBooks page since they display text only 

after clicking on the graphic or image (whereas Scrolling Sidebar windows are always displayed). 

In addition to glossing cultural notes, which can be done easily with Scrolling Sidebar, too, Pop-

Overs could also be used to gloss lexical terms presented as graphics or images. For example, if 

learning about different nationalities, which is fairly standard in many beginning-level textbooks, 

flags could be displayed with captions asking which country they represent and instructions to 

click on the flag to find out. Such an activity could then be followed up with a Review widget 

(using either multiple-choice questions or drag-to-target activities), which could be on the 

following page or linked to using the hyperlink Inspector.  

 

The other three widgets available in iBooks Author 2.0, Interactive Image, 3D image, and 

HTML, are less immediately useful for creating original teaching materials in Chinese and will 

only be introduced but not discussed in detail. The Interactive Image widget allows readers to 

zoom in on a location in an image by clicking on a text box associated with that location. 

Perhaps this widget could be used, say, with a bird’s-eye view photo of the Forbidden City. Text 

boxes could be added through the Inspector for Tiananmen, Hall of Supreme Harmony, Palace of 

Heavenly Purity, and the Imperial Garden and set to their corresponding location in the image. 

Clicking on any of these text boxes would then zoom in on the places selected. For 3D 

images, .dae files can be used by inserting a 3D widget. Options for object rotation include free, 

horizontal, as well as horizontal and vertical, which can be set under the Interaction pane of the 

3D Inspector. Authors should also click on the “auto-rotate object when idle” box so that readers 

can see more easily that there is 3D image in the book. Finally, the HTML widget, which 

contrary to its name is not used for simply cutting and pasting HTML code into iBooks Author. 

The widget does allow for possible forms of interactivity, however, which must be coded in 

HTML, CSS, or JavaScript. The HTML widget requires coding knowledge and familiarity with 

Apple’s Dashcode application, which is used to design Dashboard widgets for the Mac OS. 

Dashcode is available for free by registering as a developer with Apple. More information about 

the HTML widget can be found here.  

 

https://support.apple.com/en-us/HT204433
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5. Sharing and publishing e-books created in iBooks Author 

 

After an iBook has been created and proofread, there are different ways to share or 

publish a work. Users should first preview their work before sharing or publishing it. Remember 

to switch back to “preview the entire book” under general preferences if “preview current 

selection” had been selected while working on an iBook (“preview current selection” is actually 

the recommended setting for longer works since they will preview faster in iBooks on both a 

Mac and iPad). For sharing, first export the work from an iBooks Author file (.iba) to an iBook 

file (.ibooks). This can be done from the menu (File > Export). A drop-down pane will appear 

allowing users to choose to export the file as an iBook (.ibooks), PDF, or text. After making a 

selection, users will be prompted to “save as.” A new file name and location can be specified in 

this window. Note that PDF versions of an e-book can be created through export. If multi-media 

files or interactivity are not needed, iBooks Author can still create professional looking e-books 

as a PDF file, which will work across all platforms with a PDF reader. iBook files can be shared 

different ways. If not too large, an .ibooks file, for example, could be sent as an email attachment. 

Larger files, however, are best shared through course CMS or LMS, file sharing services, such as 

Dropbox, or through iTunesU. On a Mac with iBooks 1.0 installed, the .ibooks file can be 

imported into the application simply by dragging and dropping it onto the Library window. For 

mobile devices, the .ibooks file sent as an email attachment can be saved in the iBooks library by 

tapping on the attachment file and selecting “open in iBooks,’” which will then save it in the 

user’s iBooks library automatically.  

 

iBooks created on iBooks Author may also be published through the iBooks Store.  

Clicking on “Publish” from either the Toolbar or from File > Publish in the menu will take 

authors through the process step by step, including how authors can register an account for 

iTunes Connect for iBooks. Registration is free and only requires a valid email address. iBooks 

can be made available on the iBooks Store for free or for purchase. Authors wishing to provide 

their work for both purchase and for free will need two separate emails, however. For authors 

wishing to sell their work, a ISBN number, US taxpayer ID, and bank account information to 

process payments are all required.  

 

 

6. Benefits and limitations of iBooks Author 2.0 

 

First and foremost, iBooks Author is a free download for the Mac platform (see 

requirements above). Like most Apple software products, it is intuitive and easy to use, 

especially if authors are familiar with Apple’s word processing and presentation applications, 

Pages and Keynote respectively. Yet iBooks Author 2.0 is also quite powerful and can create 

professional-looking publications with relative ease and quickly. Since iBooks Author comes 

with more than one dozen templates and layouts for both portrait and landscape modes, 

prospective authors only need to open up the application and start adding content to create an 

iBook. Drag and drop for media or Keynote files makes adding content simple, too. For more 

advanced users, the application allows for finer levels of customization as well. Customization is 

conducive to creating books or materials that are best suited for certain classroom and curricular 

needs, where rarely, if ever, is there a one-size fits all solution. Given the ease of creating e-

http://www.apple.com/itunes/working-itunes/sell-content/books/
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books using iBooks Author and it being a free application, in certain circumstances it may be 

worth adopting a social constructionist approach to authorship by having students help to create 

content as well (which would then also be social constructivist in terms of learning experience).   

 

Although the application name implies that “books” must be authored, iBooks Author is 

highly scalable, modular, and differentiated. It can create anything from the simplest of 

assignments, such as a reading or listening exercise with Review questions that follow, to a full-

length textbook complete with audio and video files (up to three gigabyte if published through 

the iBooks Store). In terms of targeting learners with different levels of proficiency, iBooks 

Author likewise can create materials appropriate for a vast range of learners, from beginner to 

advanced.  

 

Though not unique to iBooks Author, the ability to create truly multi-media content on a 

single device or computer is powerful pedagogically, especially with a language such as Chinese. 

The traditional textbook may include audio or video files either as a CD, DVD, or online. But 

physically such media is separate from the text itself. Playback, listening, and viewing involves 

using another device to listen or view. With iBooks Author, on the other hand, text and media 

can be integrated, which provides practical convenience and pedagogic benefits to learners. 

There is no time lag either between the reading of text and the ability to listen or view video 

related to that text. Other applications, such as Skritter or electronic flashcards, though not a part 

of an iBook, can be used on the same computer or mobile device as well, making either platform 

an even more powerful tool for one-stop integrated language learning.  

 

Another benefit of using iBooks Author to create materials is being able to easily modify 

or change course content. The traditional printed textbook cannot do this until a revised edition 

comes out, which is very limiting and costly for publishers. Emendations can be crucial for 

certain types of content where relevancy and up-to-date information prove important. For 

example, any content covering the news or current events had best be relatively recent. It will be 

presumably more interesting and relevant to students’ own lives, and thus enhance motivation for 

learning. It can also allow students to contextualize certain information and develop 

metacognitive strategies to enhance their understanding, whether it be a reading or listening 

exercise. As Auer has shown, using the iBooks Author application can aid in promoting reading 

strategies and autonomous learning (Auer). Conventional textbooks (such as the Yale series of 

textbooks for reading newspapers) obviously cannot do this as well. Unless one is a historian or 

archivist, there is no need for language learners to read outdated newspapers anymore. But 

reading about current events, such as the outbreak of MERS or developments in Sino-US 

relations, through reading material created specially for iBooks, students may feel more familiar 

with, engaged, and thereby more interested in the material, thus stimulating learner motivation. 

They will also be able to apply information gleaned from news in their native language as part of 

a reading or listening strategy, which may help them better understand news or popular culture 

content in Chinese. Another more practical example could involve content about, say, taking the 

subway in Beijing. This is something every student traveling to China for study abroad should 

learn about. In late 2014, subway fares there changed from two yuan for a ride regardless of 

destination to a system where passengers pay according to the distance of their ride, starting at 

three yuan. Had a unit about taking the subway based on old information been created as content 

for an iBook, it would be quick and easy to update this information in iBooks Author to reflect 
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the current situation. Linguistically and practically speaking, having relevant, useful, and up-to-

date information available is better for learning.  

 

An additional benefit iBooks Author created iBooks, available only on iBooks 1.0 for the 

Mac platform, is the capability to look up Chinese terms using Apple’s Dictionary application, 

which includes two excellent Chinese dictionaries for free as part of its 10.10 operating system 

(see above). By simply using a special key or trackpad command (such as a three-finger tap), 

highlighted Chinese terms will be defined by the Dictionary application in a pop-up window. 

This is a most powerful tool for learning Chinese, especially at the advanced levels, as it saves 

time looking up terms in a conventional print dictionary, which can be tedious. With the 

BetterDictionary extension added, terms can also be saved in Apple’s Dictionary application for 

review later. In iBooks 1.0 for the Mac, there is also an option to highlight text, right click, and 

have the selected text read aloud. To do this in Chinese, a Chinese “voice” must be downloaded. 

This can be done for free through Apple and by adding a Chinese voice to the “Dictation & 

Speech” preference pane under System Preferences. After downloading a voice, such as Ting 

Ting, go to System Preferences and select “Dictation & Speech.” There choose “Chinese” under 

“System Voice” and add the voice you wish to read aloud Chinese text.  

 

The limitations to using iBooks Author and iBooks are primarily related to platform. To 

maximize the benefits of the authoring software, any work created using iBooks Author and 

exported as .ibooks must be viewed on the iBooks application, which runs exclusively on the 

Mac and iOS platforms. So intended readership must own or have access to either Apple 

computers (desktop and laptop), iPads, or iPhones. Even though iPhone ownership has increased 

dramatically, with over 700 million sets being sold worldwide and Apple holding up to 40% 

market share in some areas (Costello), reading iBooks on the iPhone is rather restricted, 

especially for the needs of instructional materials in Chinese. Many schools, however, do have 

Apple computers available in language labs and resource centers. Students in some school 

districts are being issued iPads, too. Greater availability of Apple products mitigates the platform 

problem somewhat. Yet, the issue still persists and must be taken into serious consideration when 

deciding to create materials using iBooks Author.  

 

To get around platform requirements, there are options, of course, to export as .pdf or text 

files. But then iBooks Author loses its superiority in interactivity (widgets) and  providing 

“transformative content,” as well as all multi-media capability, producing nothing more than the 

equivalent of a conventional hard-copy book readable on mobile devices and computers. Perhaps 

Apple will one day develop a Windows version of iBooks, just as it did with iTunes for 

Windows. It also took Apple three years, however, to develop and release a version of iBooks for 

just the Mac platform (version 1), which offers many benefits not available on iBooks 3.0 for the 

iOS platform. But books are far less profitable for Apple than music in terms of gross revenue. 

Some suggest, too, that Apple has even inflated its numbers regarding revenue generated by 

iBook sales (Hoffelder), which estimates put at around one billion dollars for 2013 (compared to 

over 10 billion dollars in revenue from music sales through iTunes). The issue of continued 

development always presents a concern when committing to a new technology. But since Apple 

does make money off the sale of iBooks created using iBooks Author, the company has a 

monetary incentive to continue development of the application. It is hoped that additional new 

features will be made available, too. One feature already present in the latest versions of Pages 
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and Keynote that would presumably be easy to port to iBooks Author is “add phonetic text,” or 

ruby superscript, for Japanese and Chinese characters. This would make iBooks Author an even 

more attractive choice for creating instructional materials for the Chinese classroom. One final 

shortcoming related to the Review widget is the lack of any way to keep track of progress in 

terms of individual performance on any given assignment. Students could, of course, write down 

the number of correct answers for each assignment. But an automated system to track 

performance would work better and benefit students in terms of providing another form of 

feedback.  

 

In the end, authors can determine best the lay of the land locally and decide whether or 

not iBooks Author suits their needs and their readership. Accessibility and availability, however, 

remain the crux of the matter. Thanks to support from the Director of Benedictine University’s 

Center for Teaching and Learning Excellence, Dr. Cheryl Heinz, and the Provost, Dr. Maria de la 

Camara, fall 2015 iPads will be made available to each student registered for Chinese at 

Benedictine University’s main campus. I am currently developing supplementary materials using 

iBooks Author to complement the e-book version of Integrated Chinese, which will be adopted 

for CHIN 101 fall 2015 at Benedictine University. For intermediate and advanced language 

courses, I will use iBooks Author to create original instructional materials, primarily for 

vocabulary, listening comprehension, and reading exercises. The interactive aspects of iBook 

Author’s widgets, especially Review and Gallery, will, I believe, help students to better acquire 

vocabulary, improve their listening comprehension skill through immediate feedback, and 

enhance their reading abilities by helping them to develop autonomous learning habits and 

metacognitive strategies. Feedback on the use of iPads and iBooks will be solicited at the end of 

each semester for qualitative research purposes; students will be asked how they think the use of 

iPads and iBooks impacted learning. For the intermediate and advanced courses, students will 

also be asked to compare their experience using iPad and iBooks in terms of learning to prior 

semesters when course materials were exclusively in the form of textbooks or textbooks with a 

companion website.  

 

Finally, to return to Roland Barthes and the death of the author cited at the beginning of 

this article. It seems clear that far from being dead, authorship has survived and is even thriving. 

With iBooks Author, original instructional materials with clear pedagogic benefits can be created 

easily for the Chinese classroom by an author-instructor. Whether iBooks created using iBooks 

Author supplant or merely supplement existing textbooks, having the ability to author one’s one 

materials is empowering and will, I believe, benefit both our language students and the field of 

Chinese language pedagogy.  
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